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I. INTRODUCTION 

Millions of women worldwide spend significant portions of their lives at formal workplaces. The 
International Labour Organization reports that 1.2 billion women were employed globally in 2008;1 
nearly 220 million of these women are employed in industry. Although industry is a broad category, it is 
most often characterized by groups of employees working at a location to produce goods. The aggregation 
of the employees can make the efficient provision of certain employee benefits possible. For example, 
many companies provide day care and health services on site for their employees. 
  
Women of reproductive age have unique needs in the workplace. Very often women are responsible for 
the day-to-day care of children. Also, the demands of the workplace make obtaining preventive health 
care services, including prenatal care and family planning, very difficult. Hours can be long and often 
include work on Saturdays, precluding visits to government health clinics, which may be open only 
during regular business hours. 
 
Despite these challenges, employers are increasingly investing more in training women in the workplace. 
Examples of such industries are business process outsourcing and electronics manufacturing in South and 
East Asia. This sizeable investment means that employers are increasingly concerned with retention of 
women employees. Among the benefits that employers can offer in hopes of retaining female employees 
are day care, on-site health services, and family planning services. 
 
Incentives that employers can use to retain women employees are not limited to those revolving around 
childbirth. Transportation, flexible scheduling, teleworking, improved job satisfaction, community 
building, and life skills training are examples of other benefits that might lead women to remain with an 
employer. Together, this collection of mutually beneficial items might be called the building blocks for a 
Family-Friendly Workplace. 

Uses of the Family-Friendly Workplace Policy Model 
The Family-Friendly Workplace (FFW) Model is designed to engage individuals and groups from diverse 
institutions in all sectors to make workplaces more family-friendly. The FFW model will help 
reproductive health advocates and employers of women understand the benefits and costs of 
implementing policies that support women in their reproductive years. Users of the model may be human 
resource departments of medium-sized and large companies, family planning advocates, maternal health 
advocates or groups representing women in the workplace. 
 
Policy models are designed to answer a number of “what if” questions relevant to entities as small as local 
providers of primary health care services and as large as international corporations.  The “what if” refers 
to factors that can be changed or influenced by policy decisions, and decisionmakers often analyze these 
factors in response to demands by stakeholders or employees, social pressure, or the need to comply with 
anticipated changes in legal code. 
 
Models are commonly computerized when analysts need to see the likely result of two or more forces 
potentially affecting an outcome, such as a population’s illness level or its degree of urbanization. 
Whenever at least three variables are involved (such as two forces and one outcome), a computerized 
model can make it easier to calculate and comprehend the results. 
 

                                                 
1 International Labour Organization. 2009. Global Employment Trends for Women. Accessed on May 5, 2009, 
http://www.ilo.org/wcmsp5/groups/public/---dgreports/---dcomm/documents/publication/wcms_103456.pdf. 
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Policy models such as the Family-Friendly Workplace commonly help raise awareness of the following: 

 The usefulness of early action. Modeling shows that little in a country or company stands still 
while policy decisions are stalled, and that many negative outcomes can accumulate during a 
period of policy stasis. 

 The costs vs. the benefits of a course of action.  Modeling can show the economic efficiency of a 
set of actions (i.e., whether certain outcomes are achieved more effectively than under a different 
set of actions) or simply whether the cost of these actions is acceptable for the benefits gained. 

 How a group’s composition influences its needs and well-being. A group’s composition—the mix 
of age, sex, and marital and family status—has broad-ranging consequences for many outcomes, 
including health needs and productivity, and job satisfaction and retention. Modeling 
demonstrates the degree to which a change in family status (having fewer unintended 
pregnancies, for example) can affect a range of indicators, such as the company costs for 
maternity leave. 

 

Organization of the Manual  
The Family-Friendly Workplace Model manual begins with a brief introduction and a description of the 
common uses for a model of this type. The manual also explains the model’s design, the data decisions 
and assumptions needed before the model can be run, and possible sources for the data. It then defines 
data inputs and outputs step by step. For reference, the user may also consult the USAID publications 
“Family-Friendly Workplace: A Model to Assist Organizations in Analyzing and Implementing Family-
Friendly Policies” and “Family-Friendly Workplace” for further illustration concerning the business and 
legal cases for implementing family-friendly benefits, other uses of the model, and an example of how the 
model has been used recently by a large company. 
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Model Design 
The model is designed in an easy-to-use format, with a simple file management system and similarly 
formatted screens for entering inputs and displaying outputs. There are “File” and “View” dropdowns on 
the heading bar throughout the program, which contain menus for quickly navigating through the model. 
The “File” dropdown menu allows the user to open, save, and close projections, while the “View” 
dropdown menu allows the user to open five editor screens to input data and the display screens to view 
projection outputs, such as charts. All editor screens are similar in structure; the user can navigate 
between them easily by clicking on the tab at the top of the screen that shows the editor screen’s name. 
One very convenient feature of this program is its ability to display editing and display screens side by 
side, allowing the user to see the changes in output immediately following changes to input. The 
following is an example of this feature: 
 

 
 

 On the first editor screen, “Benefits,” the user chooses the type of benefits he/she wishes to 
examine with the model.    

 On the following four screens, the user enters the “scenario” to which each benefit will be applied 
and the associated scenario costs. The “Workforce statistics” screen describes the workforce 
composition, family status of those workers, employee attrition rates and reasons for leaving, 
absenteeism, and the time and financial commitments for recruiting and training a new employee.  

 The “Family planning and health” screen allows the user to enter costs for a family planning 
program, maternal health benefits, maternity leave, infant health program, breastfeeding program, 
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and counseling sessions to support women confronting family pressure to terminate employment. 
In addition, this screen allows for data on the unmet need for family planning, the probability tha
a female employee will become pregnant, the average number of avoidable sick days related to 

t 

ity.   

 childcare, and average leave averted 
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ve averted with that benefit, and the percent reduction in 
turnover if the benefit is implemented.  
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ow the following: 

nning benefits program  

 to implement the program 
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• Turnover before and after benefits modifications 
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nd ability to work. However, this should be done only if 
ou can ensure the anonymity of respondents.   

 

 
changes affect the outputs of the model; 

this will let you establish the lower and upper limits of impact. 

pregnancy morbidity, and the average number of avoidable sick days related to infant morbid

 The “Infant/child care” screen lets the user input the costs of infant daycare and after-school 
childcare programs, percent of employee turnover related to
if on-site daycare or after-school childcare were available.  

 The “Work environment” page allows the user to enter data for benefits, such as flexible 
scheduling, teleworking, and up to three other benefits of the user’s choosing. For each benefit 
the last editor screen, the user enters the annual cost per participating employee, the percent of 
employees participating, the average lea

 
The model will then project the comparative cost savings of implementing the benefits program.  T
output can be viewed on numerical output data screens and charts. The charts sh

• Pregnancies averted with use of the family pla
• Savings accruing due to the benefits program 
• Necessary expenditures
• Days of averted le
• Turnover averted 
• Cost-benefit analysis of the program 
• Absenteeism before and after the benefits program

Gathering Data 
Data for the Family-Friendly Workplace Model will come primarily from the human resources (HR) 
department of the company. HR staff can provide statistics on the composition of the workforce, the
family status of employees, current benefits provided, benefits costs, and employee participation in 
benefits programs. To estimate the potential for expanded or new benefits to increase employee health 
status and retention, you will need input from HR officers as to why employees terminate employment 
and what unmet needs employee benefits could address. It may also be useful to conduct an anonym
employee survey to ascertain views on current challenges to working and the potential for various 
benefits to improve employees’ job satisfaction a
y
 
In Section 2.2.2, Workforce Statistics, a three-column table describes the inputs needed for each screen.
The first column, “Data item,” shows the input as labeled in the model. The second column provides a 
more detailed description or rationale for the input. The third column, “Potential source,” presents advice 
on where to find information for the input. Many inputs will require estimation by the user, however, so it 
is strongly recommend that you conduct a brief sensitivity test when you use estimates. This can be done
by changing the input value up or down and observing how the 
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Installing the Model 
The Family-Friendly Workplace Model is distributed on CD-ROMs or through the Internet at 
www.healthpolicyinitiative.com. The model will operate on any computer running Windows 95 or later 
versions of Windows.   
 
To install the Family-Friendly Workplace Model, follow these directions:  

• Installing from a CD-ROM. Insert the CD-ROM into your CD-ROM drive. The installation 
program should start automatically. If it does not, select “Start” from the task bar and “Run” from 
the pop-up menu. In the dialogue box that appears, click on Browse, locate the file 
ffworkplace.EXE, and then press “Ok.”    

• Installing from the internet. Start your Internet browser and go to 
www.healthpolicyinitiative.com. Click on “Software” and then “Family-Friendly Workplace.” 
From the next dialogue box, select “Save.” Select a location for the file. Once the file has been 
downloaded, click on that file and the follow the instructions.  

 
 
 

http://www.healthpolicyinitiative.com/


 

II. CREATING A NEW PROJECTION 

Opening a Projection 
To begin a new projection, click on “File” and then choose “New” from the drop-down menu.  A dialogue 
box labeled “Open” will appear. Choose a file name for your projection and type it in the space labeled 
“File name.” Then click “Open.” 
 
To work on a previously created projection, click on the “File” drop-down menu and choose “”Open.” 
Highlight the projection in which you would like to work and click on “Open.” You may have up to two 
projections open at the same time. 

Input the Data 
To begin input, click on the “View” drop-down menu and choose “Edit.” You will see the names of the 
editor screens on tabs near the top of the dialogue box that houses the five screens. You will then see the 
editor screens, beginning with “Benefits.” 
 
The Family-Friendly Workplace Model has five editor screens for entering data:  

 Benefits 
 Workforce statistics 
 Family planning/health 
 Infant/child care 
 Work environment 

 
To make a projection, enter the benefits you propose to explore, their costs, the potential leave and 
turnover averted, and the percent of employees you expect to take advantage of the program. The model 
then projects your net savings by changing the benefits package, and compares this to what might have 
occurred had you not adjusted the package.   
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Benefits 
Click on “View” and then “Edit” to go to the “Benefits” page.  It will look like the following: 
 

 
 
On the Benefits screen, you will see a list of the most commonly offered family-friendly benefits. When 
you click on the box next to the benefits you wish to include, a check mark will appear. 
 
Lower on the same screen, under “Workplace Improvements,” type in any other benefits you would like 
to include that are not yet displayed. These may include such things as a fitness center, a meal discount 
program, or bus/van service. Then click on the “Set workplace improvements” button below your entry. 
 
It is strongly advised that you save your work as you go. If it is the first save, click on the “File” drop-
down menu, select “Save as,” and name your document. This will save every editor screen you have 
worked on that day. The other screens that you may select are the Display and Charts screens which do 
not require saving since they are based on the Editor screen's dataSelect a location for your document, and 
click “Save.” If you have previously saved the document and want to update the information without 
saving it as a new document, then simply click “File,” followed by “Save.”  
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Click on the “Workforce statistics” tab at the top to move to the next input screen. 

Workforce statistics 
The top of the “Workforce statistics” editor screen will look like the following: 
 

 
 
You will need to use the scroll bar on the right side of the screen to view the entire page. This screen 
contains data describing the workforce at the company. Benefits defined in subsequent screens will 
interact with this baseline set of information to produce outputs (the results of implementing new 
benefits). 
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Enter data for each of the following data items: 
 

Workforce Statistics 

Data item Description Potential source 

Number of employees All employees in the company or 
unit of the company 

Company records 

Percent women Percent of employees who are 
women 

Company records 

Percent of women who are 
married 

Percent of employees who are 
married or sexually active 

Company records 

Percent of women with children Percent of women with children 
who need child care—either as 
infants, toddlers, or in after-school 
programs 

Company records, anonymous 
survey, or best estimate 

Average number of children per 
woman 

Number of children per woman who 
need child care 

Company records, anonymous 
survey, or best estimate 

Percent of children who are 
school aged 

Percent of children needing child 
care who are school aged 

Company records, anonymous 
survey, or best estimate 

Average annual wage Total average annual compensation 
of female employees, in local 
currency 

Company records 

 
Attrition 

Data item Description Potential source 

Attrition rate Percent of employees who voluntarily 
quit work per year (number of annual 
job leavers divided by number of 
employees mid-year) 

Calculation from company records 

Causes of attrition   

     Child care issues Difficulties in caring for dependent 
children and maintaining work 

     Pregnancy or childbirth Women not returning after childbirth 

     Family pressure Pressure from husband, in-laws, or 
other relatives to not work 

     Work scheduling Inability to fit work schedule to family 
or other responsibilities 

     Work conditions Job leaving that may have been 
prevented by workplace amenities or 
changes 

     Other  

Company records (analysis of exit 
interviews), population-based 
surveys of employees, best 
estimates 
 
Note:  sum of these causes must 
equal 100 percent. 
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Absenteeism 

Data item Description Potential source 

Absenteeism Unscheduled leave Company records 

Number of work days per year Number of days that an average 
full-time female employee works 
in a year. (It is possible to include 
part-time workers; however, 
annual wages should be adjusted 
to reflect the proportions who 
are part time or full time if the 
total includes part-time 
employees 

Company records 

 
Employee Recruitment and Training 

Data item Description Potential source 

Average recruitment costs Advertising and value of human 
resources labor required to 
recruit and hire an employee 

Company records 

Average non-labor training costs All costs associated with training 
an employee, except the value of 
the trainee’s time 

Company records 

Number of days to fully train an 
employee 

Number of days before an 
employee is a fully functioning 
member of the company 

Company records 

 
When you have completed data entry, save this screen and click on the “Family planning/health” tab to 
move to the next editor screen. 
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Family planning/health 
When you click on the Family planning/health tab, you will see the following screen: 
 

 
In this screen, you enter descriptions for the benefits for family planning, maternal health, maternity 
leave, breastfeeding support, infant health, and counseling.   
 

11 



 

Here are more detailed descriptions of each input variable:  
 

Family Planning 

Data item Description Potential source 

Cost per eligible employee Average additional cost of 
supplying family planning services 

International Planned Parenthood 
chapter, National Family Planning 
Programme 

Percent of women using family 
planning in absence of sponsored 
benefit 

Percent of women currently 
using family planning 

National Demographic and 
Health Survey—percent of 
working women using family 
planning 

Percent of women in need of 
family planning 

Percent of women who might be 
interested in using family planning 

National Demographic and 
Health Survey—percent of 
working women using family 
planning, plus unmet need 

Annual probability of becoming 
pregnant (in absence of family 
planning) 

Percent of women who are not 
using family planning who would 
become pregnant 

National Demographic and 
Health Survey 

Annual probability of becoming 
pregnant (users of family 
planning) 

100 percent, minus contraceptive 
failure rate 

National Demographic and 
Health Survey 

Probability that a new mother 
will terminate employment 

 National survey, company 
records, or best estimate 

 
Maternal Health Benefits 

Data item Description Potential source 

Health/insurance cost per 
pregnant woman 

Cost to purchase insurance or 
provide maternal health services 

Insurance provider estimate, best 
estimate 

Percent of pregnancy-related 
leave averted with benefit 

Percent by which pregnancy-
related leave is reduced because 
of better antenatal health and/or 
availability of on-site services 

Best estimate 
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Breastfeeding support 

Data item Description Potential source 

Total cost of setting up room or 
space for breastfeeding mothers 

Incremental cost of setting aside 
a quiet, private room for 
breastfeeding 

Company records—implicit 
valuation of allotted square feet  

Percent of mothers with infants 
availing of benefit 

Percent of mothers likely to 
breastfeed at work 

Best estimate or anonymous 
company survey 

Percent reduction in absenteeism 
due to child illness 

Children breastfeeding with their 
mothers are healthier than those 
who do not 

Best estimate or using National 
Demographic and Health 
Survey—average incidence of 
childhood diarrhea, divided by 
annual number of work days 

Percent reduction in maternity 
leave as result of breastfeeding 
support 

Mothers with a place to 
breastfeed infants are more likely 
to return to work more quickly 

Best estimate, national survey, or 
anonymous company survey 

 
Infant Health 

Data item Description Potential source 

Annual cost per infant Cost to purchase insurance or 
provide infant health services 

Insurance provider estimate, best 
estimate 

Percent of infant-health-related 
leave averted with benefit 

Regular health care for children 
usually leads to healthier children 
who are sick less often 

Best estimate 

 
Counseling Services 

Data item Description Potential source 

Cost of counseling session Payment to provider per session Estimate provided by mental 
health professional 

Number of sessions per 
employee 

Average number of sessions per 
availing employee 

Best estimate, discussion with 
mental health professional 

Percent of employees availing  Anonymous employee survey or 
national survey 

Percent of family-pressure-
related leave averted with benefit 

Family pressure often leads to an 
employee quitting work; family 
or individual counseling can 
reduce this source of job leaving 

Best estimate, anonymous 
employee survey, or national 
survey 

 
Remember to keep in mind exactly what you are projecting. For example, if the cost of the benefit will 
not be subsidized by the company (i.e., if it is fully paid by the employee), the entry under counseling 
services labeled “Cost per counseling session” will be set at $0.   
 
When you have finished entering data, save this screen and click on the “Infant/child care” tab to move to 
the next editor screen. 
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Infant/child care 
When you click on the “Infant/child care” tab, you will see the following screen: 
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Here are more detailed descriptions of each variable you will enter:  
 

Infant Care Benefits and Child Care Benefits 

Data item Description Potential source 

Subsidized infant care benefits   

Annual cost per child Full cost of providing or 
contracting for service 

Discussion with infant care 
contractor 

Share paid by parent (percent) Percent that would be paid by 
parent 

Employer decision 

Percent of parents availing of 
service 

Percent of eligible parents likely 
to use the service 

Best estimate, anonymous 
employee survey, or national 
survey 

Percent reduction in turnover 
related to infant care 

 Best estimate, anonymous 
employee survey, or national 
survey 

Percent of infant-care-related 
leave averted with benefit 

 Best estimate, anonymous 
employee survey, or national 
survey 

Subsidized child care benefits 
(after school) 

  

Annual cost per child Full cost of providing or 
contracting for service 

Discussion with child care 
contractor 

Share paid by parent (percent) Percent that would be paid by 
parent 

Employer decision 

Percent of parents availing of 
service 

Percent of eligible parents likely 
to use the service 

Best estimate, anonymous 
employee survey, or national 
survey 

Percent reduction in turnover 
related to child care 

 Best estimate, anonymous 
employee survey, or national 
survey 

Percent of child-care-related 
leave averted with benefit 

 Best estimate, anonymous 
employee survey, or national 
survey 

 
When you are finished entering your data, save this screen and click on the “Work environment” tab to 
move to the next editor screen. 
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Work environment 
When you click on the “Work environment” tab, you will see the following screen: 
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Use the scroll bar on the right to view all contents of the screen. The benefits shown on this screen 
include flexible scheduling, teleworking, and any other workplace improvements you named for 
consideration on the “Benefits” screen. For each, you will need to enter the expected cost and the percent 
of employees participating. Remember to save the inputs for this screen.  
 

Teleworking 

Data item Description Potential source 

Flexible Scheduling   

Annual cost per participating 
employee 

Cost to company per person 
involved with flexible scheduling 

Employer estimate 

Percent of employees 
participating 

Percent of employees electing to 
use flexible scheduling 

Employer estimate of eligible 
employees and number of 
employees likely to accept 

Percent of scheduling-related 
leave averted 

Percent of scheduling-related leave 
averted because employees can 
work their schedules around 
family issues 

Best guess, anonymous employee 
survey, or national survey 

Percent of scheduling-related 
turnover averted 

Percent of turnover averted 
because employees can work 
flexible hours 

Best guess, anonymous employee 
survey, or national survey 

Teleworking   

Annual cost per participating 
employee 

Cost to company per person to 
set up an employee for 
teleworking 

Employer estimate 

Percent of employees 
participating 

Percent of employees electing to 
telework 

Employer estimate of eligible 
employees and number of 
employees likely to accept 

Percent of scheduling-related 
leave averted 

Percent of scheduling-related leave 
averted because employees work 
from home 

Best guess, anonymous employee 
survey, or national survey 

Percent of scheduling-related 
turnover averted 

Percent of turnover averted 
because employees can work from 
home 

Best guess, anonymous employee 
survey, or national survey 

Workplace Improvements   

Cost per employee Cost of the program, divided by 
number of employees 

Employer estimate 

Percent of related leave 
averted with workplace 
improvement 

Percent by which work condition 
leave is lowered by the benefit 

Best guess, anonymous employee 
survey, or national survey 

Percent of related turnover 
averted with workplace 
improvement 

Percent by which work condition 
turnover is lowered by the benefit 

Best guess, anonymous employee 
survey, or national survey 
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Projecting a scale-up of currently offered benefits 
The model assumes that you are starting from a baseline of “zero,” or no family-friendly benefits offered. 
Some companies may already be offering some (or even many) of these benefits. In that case, the model 
user can explore two analysis options: 

 Two scenarios can be run. The first analyzes the use of current benefits and their impact, while 
the second analyzes the impact of expanded benefits. The user can then compare the difference in 
the outputs, such as maternity leave averted, turnover averted, and other cost savings. 

 One scenario can be run. In this mode of analysis, the user will input the change in uptake of each 
benefit, from the current to the expected level. For example, if 20% of the workforce currently is 
using the infant care program, and through an initiative such as a promotion effort of the infant 
care program, it is expected that 50% of the workforce will participate, the user can input the 
difference (30%). Thus, the outputs this model will show represent the marginal impact 
anticipated due to a change from the current level of benefits used to the potential future level of 
benefits offered and used. 

 
The two methods will yield the same results as long as the same projection parameters are used.  
 
Please note, however, that if your company currently has some benefits and you want to look at 
increasing them, you will have to include any cost changes in addition to workforce participation 
increases in the benefit programs. In the infant care example above, if 20% of employees had used the 
program while it was not subsidized by the company, and you expect to subsidize the program at a cost of 
$500 per employee in the future to attain 50% employee participation, you will need to input a change in 
cost of $500 (per employee) in addition to entering a change of 30% for employee participation. 
Following this example through, you would go to the line “Annual cost per child” under the subhead 
“Subsidized infant care benefits” and change $10000.00 to $10500.00. 
  
When you are finished entering the data, make sure that you save all your inputs. You may then click on 
the “Close” button at the bottom of the editor and start viewing the outputs. 
   



 

III. VIEWING THE OUTPUT 

You may view the projection output in the form of either summary data tables or charts. Remember that 
you can view projection output tables or charts side-by-side with the editor input screens. 

Summary Tables 
To view summary tables, click on the “Display output” button at the bottom of any editor screen.  You 
may also click on “View” at the top left and choose “Display” from the drop-down menu.  There will be 
five summary tables that you can view: 

 The “Summary outputs” table summarizes all of the output information found on the four tables 
that follow it. 

 “Demographic impacts” describes the impact of pregnancy prevention. 
 “Family planning/health” shows the expected expenditures on family planning, counseling, and 

maternal and infant health, and the expected savings from averted leave, averted turnover, and 
other such productivity increases. 

 “Infant/child care” shows the expected expenditure on infant and child care and the resulting 
savings anticipated from various productivity increases. 

 “Workplace environment” describes the expected expenditure on flexible scheduling, 
teleworking, and any additional workplace improvements you have decided to evaluate.  The 
resulting expected savings from various productivity increases is also displayed. 
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Below, you can see an example of a summary table screen set next to an editor screen. The user can 
change numbers in the editor screen on the right and immediately see changes to output in the output 
screen on the left. 
 

 

Charts 
To view the results of the projection in pie or bar chart format, click on “Display charts” at the bottom of 
the editor screen. You also can click on “View” and then choose “Charts” from the drop-down menu. 
There will be eight charts for viewing: 

 “Pregnancies” shows a breakdown of potential pregnancies among female employees: the total of 
actual pregnancies, as well as those prevented by independent employee action or as a result of 
the benefit program. 

 “Benefit” describes the savings resulting from implementation of the benefits program. 
 “Cost” shows the expenditures necessary to implement the benefits program, broken down by 

benefit type. 
 “Averted Leave” shows the days of averted leave, broken down by the type of benefit that 

enabled the employee to avert taking leave.  
 “Turnover” does the same for turnover averted. 
 “Cost Benefit” displays a bar chart comparing total expenditures to total savings. 
 “Absenteeism” shows in bar chart format the number of absenteeism days before and after 

implementation of the benefits program. 
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 “Turnover” displays the same for the number of employees who left the company before and after 
the benefits program. 

An example of a chart display follows. Again, the user may make changes in the editor screen on the right 
and see changes immediately in the chart at the left. 
 

 
 
When you are finished viewing the displays, click the “Close” button at the bottom of the screen.  To exit 
the program, click on the “File” drop-down menu and choose “Exit.” Be sure to save the file to retain any 
changes you have made. 
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